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Accessible Podcasting Schedule:
10:00 - Intro
10:15 - History and Overview of Podcasting
11:15 - Using iTunes to Gather Podcasts
11:45 - Lunch
1:00 - File Management and Playlists
1:30 - Captioned Video Podcasts
2:00 - Break
2:15 - DAISY to Audiobook
4:30 - End
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Overview of Podcasting 
The growing popularity of distributing information over the internet via RSS 
feeds, commonly known as “Podcasting”, has been around for many years, 
under different names and accompanied by a few specialized terms. Whether 
discussing the details of how one creates the content of the podcast, or how one 
accesses the content itself, you may have heard terms being thrown around such 
as “aggregator”, “validator”, “browser”, “reader”, “feeder”, “iTunes”, “iTunes 
Store”, “iUniversity”, and of course “iPod” with all of the variations therein, 
“Shuffle”, “Photo”, “Nano”, “5th Generation” or “Video”… the list goes on with 
many competing brand names of both software and hardware. 

No matter what you call the tools and processes, the act of podcasting can be 
reduced to three very simple categories: creation of digital content, distributing 
digital content over the internet, and accessing this digital content. The 
following information and exercises will provide the basic information you need 
to know for using iTunes to create and enhance digital content to maximize the 
accessibility of this digital content by people with disabilities.

Creating (and enhancing) Content for Podcasts
The process of creating digital content is varied and can be equally simple or 
complex. While you may be engaged in creating original content, it is equally 
likely that you will find yourself enhancing somebody else’s podcast to increase 
the accessibility of the content. 

The simplicity of creating an RSS feed and the popularity of Podcasting has 
led to many different software applications featuring some sort of “export 
to Podcast” functionality. This means that you will probably be dealing with 
podacsts from a growing number of people, and podcasts that were created with 
a wide range of applications. Fortunately, iTunes offers the ability to manage 
many types of digital media files and podcasts, allowing you to more easily deal 
with all of these digital files regardless of how they were made.

Although iTunes serves well as a manager of media files, you will still need to 
use other applications in the process of making podcasts accessible. At the core 
of the issue is the fact that podcasts are really just text, audio, and video files 
placed on a website. The same tools used to make accessible video and audio 
files will be a core part of your accessible podcasting toolset.

Distributing Digital Content as a Podcast
At the most basic level, a podcast is simply digital content you place on your 
website. The differentiating factor between a podcast and any other digital 
content you link to is the RSS Feed. The RSS Feed is XML code that describes 
the digital content of your podcast, and makes it available to “aggregators” 
programs that will check for updated content and download it. 
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The RSS feed includes basic information about your digital content such as 
Title, Description, and the link to the file, but an RSS Feed can also include 
other more detailed information. Together with the digital content being linked 
to, this information makes up the actual “podcast” and is used by people to 
organize and distribute the digital content over the internet. 

Accessing the Podcast
By design, accessing podcasts is a simple thing to do, and there are several 
applications that incorporate the ability to collect, or “aggregate” podcasts and 
display their contents. There are many specialized software applications used 
to organize and download different kinds of podcasts. Known as “aggregators”, 
“readers”,  “gatherers”, and a variety of other terms, these applications are 
sometimes dedicated to gathering and playing specific types of digital content, 
such as news, blogs, music, stock prices, and weather information, just to name 
a few. Others are able to gather and display a wide range of digital content.

With the growing popularity of the iPod devices and the free availability of 
the iTunes application, we will be focusing on the iTunes application as a tool 
to access and organize podcasts and other digital content. Even if you don’t 
distribute digital content over the internet, you can use iTunes to package 
information with your digital content and load this information onto an iPod.

Accessibility of Audio and Video Formats
There are some features of the iTunes application that lend themselves to 
enhancing audio and video files for increased accessibility. However, it is 
important to remember that both iTunes and iPods are inaccessible by their 
design. Fortunately, the features built into iTunes that allow for the easy editing 
of information for greater usability also lend themselves to creating greater 
accessibility, even if it is an unintended use.

iPod Overview
There are many models of iPods, and some are more accessible than others. If 
you have requests to put alt media on an iPod, it is very important to know what 
model of iPod the student has before you begin.

Current iPod Models
Currently, there are three base models of the iPod available from Apple. They 
are the iPod (5th generation or Video), the iPod Nano, and the iPod Shuffle. All 
of these models are available with differing amounts of storage capacity. It is 
important to note that the iPod Shuffle has no LCD screen.

You can find detailed information about different iPod models currently 
available form Apple at www.apple.com. There is also an excellent iPod 
Comparison of all the iPod models ever made, at Wikipedia: http://en.wikipedia.
org/wiki/IPod

http://en.wikipedia.org/wiki/IPod
http://en.wikipedia.org/wiki/IPod
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Format Considerations for iTunes
It is possible to play many media formats in iTunes and on the various iPod 
devices, but which ones are the most accessible? It turns out that when dealing 
with media formats in iTunes, most of them will allow you to enhance the 
content for greater accessibility. Of course, there are exceptions and some subtle 
differences between the different file types.

In order to better understand the format issues within iTunes, we need to first 
look at the world of media file formats outside of iTunes. As you know, there are 
many applications used to create digital content, and while these tools deliver 
media formatted to specific standards and specifications, the companies that 
manufacture these tools inevitably want to add optional elements and slight 
variations in their interpretation of the standard specification. Recognizing 
this inevitable fact, the consortiums of peope who develop and specify the 
“standards” have allowed for extensibility in the media formats by providing 
ways to embed extra information without compromising the core content of the 
media file.

Using this extra information, manufacturers of hardware and software players 
are able to include extra functionality into their products for playing these 
“enhanced” media files. So it is that you may face several files created with 
different authoring tools- all of which are supposedly of the same format or 
“type”, but they can offer different functionality when you try to play them in 
different players.

Keeping track of which applications will deliver the format types best suited 
for your needs can be a never ending task, considering the pace at which new 
versions of authoring tools are released, and the ever-evolving media format 
standards and specifications. One of the reasons iTunes has become a popular 
tool is that it offers the ability to easily organize and manage many different file 
types, as well as the fact that it is the only way to put music on the very popular 
iPod devices.

Know What You’re Working With
Due to the wide variability of media players, it is important to know as much as 
possible about the format of your podcast files as well as the media player that 
will be used by the student needing to access the files.

While most file formats can be imported and played with iTunes, there can be 
some variation in how different applications will export information to a given 
format. This means that you can have several different files in the same format, 
and they can all still be slightly different. This is especially true when dealing 
with video files.  Audio files are generally easier to deal with, and you can use 
iTunes to transfer the embedded “extra” content when converting across file 
formats.
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Audio File Formats
There are three general ways to import audio files into iTunes: 
1)	 directly from an audio CD
2)	 Directly from your hard disk
3)	 Download from the iTunes store or as a Podcast.
 
When you import an audio file from a CD into iTunes, you are actually 
designating a file format (type) at that point and time. iTunes will read the audio 
information from the CD and convert it into a compressed file format. iTunes 
allows you to import audio files from a CD in the following formats: AAC, 
AIFF, Apple Lossless, MP3, and WAV. With the exception of the WAV and 
Quicktime audio file formats, all of these audio formats allow you to embed a 
text file within iTunes. 

It is more likely, however, that you will be importing digital audio files that 
were created for distribution over the web. You may receive these files as an 
email attachment, via a podcast, a thumbdrive, or directly across a network.

Regardless of the method of delivery, audio files are ususally in a format 
that can be directly added into iTunes. In this case, the file format remains 
unchanged when you import the file into iTunes- so if you import an MP3 or 
WAV file, it will show up in iTunes as the same file type. 

In the iTunes “File” menu there are commands to both “import…” and “add 
file”. The difference between the two is that adding a file leaves the format 
the same, where importing a file uses the importing settings from your iTunes 
Preferences to convert the file(s).

Once you have the file imported into iTunes, it is possible to easily convert 
the file into a different format by right-clicking the file and selecting the 
“convert file to” option. The file format you convert to is determined within the 
“Importing” tab of the “Advanced” tab within the “Preferences” dialogue for 
iTunes. 

Video File Formats
It is possible to import Quicktime MOV, MPEG4, and h264 format video into 
iTunes. However, it the files are going to be used on an iPod, the files need to 
be sized to 320 x 240. iTunes will allow you to embed the same information 
about artist, album, genre, etc., as is possible with audio files. In addition to 
this information, you can specify whether or not the video file is a music video, 
a television show, or a movie. Music videos will appear in the Music Library, 
whereas television shows and movies will be displayed under those same 
headings in the Library.
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RSS Feeds and Aggregators 

RSS - What’s in a name?
RSS (Really Simple Syndication, Rich Site Summary, RDF<resource 
description framework> Site Summary) 

RSS Feed: A convenient and simple method for delivering digital content 
via the internet. Using XML to specify the media format, RSS allows for the 
delivery of a wide range of digital content into a common viewer, known as an 
aggregator. An aggregator allows you to select RSS feeds to monitor and specify 
how frequently they should check for new content and how they should proceed 
with downloading it. One powerful aspect of using RSS technology is the 
ability to stop receiving content whenever you want, unlike email and Instant 
Messaging.

RSS Aggregator: Software that manages content delivered via an RSS feed. 
Sometimes called a news aggregator, feed reader, search aggregator, and news 
reader, an aggregator is simply a tool that allows you to gather and manage 
content distributed via RSS feeds.

Essential elements of an RSS feed
An RSS feed is basically a container for some sort of digital content, but in 
addition to the content itself, information can be added that describes the digital 
content, the website it came from, and the people who maintain the content and 
website.

Every RSS feed contains at least one “item” (digital content) associated with 
three primary pieces of information:
•	 Title
•	 Description
•	 Link

There are many other types of information that can be associated with items in 
an RSS feed, but the above three elements are required in every item of an RSS 
feed.

There can be up to 15 items in any particular feed, and these items are contained 
in a “channel”, which also contains at least three primary pieces of information:
•	 Title
•	 Description
•	 Link

In addition to the items contained in a channel, the RSS feed must contain 
information about which version of XML and RSS is being used.
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It is possible to create a very simple RSS feed with only these basic elements. 
Just the same, it is also possible to create much more complex RSS feeds that 
contain a wealth of extra information. Since the primary feature of XML is its 
extensibility, the possibilities for expanding the content of your RSS feed are 
primarily limited by your own imagination.

Making an RSS Feed

If  you’re not using an RSS Feed Creation Application or service, making an 
RSS feed requires some ability with html coding. If you are not comfortable 
with editing the html code of your website, please designate this task to the 
appropriate individual or department.

Creating an RSS feed by hand is often described as an easy task by people who 
are comfortable with entering HTML or XML code directly, but it may prove 
to be more of a challenge for those who are not comfortable editing their own 
code. If you are not comfortable entering and editing your own code, you may 
want to explore some RSS management applications. See the end of this section 
for more information on these resources. 

For those of you who are comfortable with entering and editing your own code, 
here is a sample of the simplest RSS feed:

<?xml version=”1.0” ?>  
<rss version=”2.0”>

<channel>

<title>Jayme’s Podcast</title> 
<description>Jayme creates a podcast with no theme or purpose, and 
updates it with dead air every week.</description> 
<link>http://www.htctu.net/ACT/podcasts.html</link>

<item> 
<title>Dead Air for February 19, 2007</title> 
<description>The latest installment of nothing</description> 
<link> http://www.htctu.net/ACT/podcasts/02192007.html </link> 
</item>

</channel>

</rss>

NOTE: When embedding images to represent an RSS feed, the <title> tag 
contents will be converted into the ALT attribute of the <img> tag when 
rendered into HTML.

While it is true that you can potentially increase the accessibility of your 
podcast by including extra information with the optional tags allowed in the 
RSS specification, keep in mind that not all aggregators recognize or harvest all 
of the optional tags.
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Aggregators
Aggregators are tools that do exactly what their name implies: they aggregate 
RSS feeds. Some of the earliest uses of aggregators were in collecting news 
posts and email communications through tools called News Readers. Today the 
use of RSS has grown to include every type of content imaginable, and many 
browsers and email clients also offer some form of aggregator functionality.

More RSS Information:

RSS Feed Creation
List Garden: Free RSS Feed Generator - http://www.softwaregarden.com/
products/listgarden/index.html
RSS specifications and other information from the RSS advisory board - http://
www.rssboard.org/
The RSS feed validator from World Wide Web Consortium - http://validator.
w3.org

Windows XP Aggregators
Opera – This free web browser offers RSS aggregator tools in addition to other 
tools for accessibility, web development, and other customization. http://www.
opera.com/
SharpReader – An RSS feed aggregator that uses Microsoft’s .NET technology. 
http://www.sharpreader.net/

Mac OS Aggregators
News Reader – A dashboard widget that allows you to view unlimited RSS 
feeds. http://www.benkazez.com/newsreader.php
MuleNewz.dock – A “dockling” that allows convenient access to RSS feeds 
via your preferred web browser. http://www.mulle-kybernetik.com/software/
MulleNewz/
iBlog – An application that allows you to create RSS-enhanced blogs as well 
as subscribe to other RSS-enabled blogs and newsfeeds. http://www.lifli.com/
Products/iBlog/main.htm

Linux Aggregators
rss2email - Get an email notification when there is updated content available.  
http://packages.debian.org/unstable/mail/rss2email
Akregator – An RSS aggregator for the KDE desktop, and works with the 
Konqueror web browser. http://akregator.kde.org/
Straw 0.26 – For the GNOME desktop, an aggregator that manages multiple 
types of feeds. http://www.gnome.org/projects/straw/
Sage – An extension for the Mozilla Firefox browser that allows for 
customization of results through style sheets. http://sage.mozdev.org/
Liferea – An online news feed aggregator for the GTK\Gnome Desktop. http://
liferea.sourceforge.net/

http://www.rssboard.org/
http://www.rssboard.org/
http://validator.w3.org
http://validator.w3.org
http://www.opera.com/
http://www.opera.com/
http://www.sharpreader.net/
http://www.benkazez.com/newsreader.php
http://www.mulle-kybernetik.com/software/MulleNewz/
http://www.mulle-kybernetik.com/software/MulleNewz/
http://www.lifli.com/Products/iBlog/main.htm
http://www.lifli.com/Products/iBlog/main.htm
http://packages.debian.org/unstable/mail/rss2email
http://akregator.kde.org/
http://www.gnome.org/projects/straw/
http://sage.mozdev.org/
http://liferea.sourceforge.net/
http://liferea.sourceforge.net/
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iTunes as an Alt Media Tool

Despite it’s inherent accessibility issues for people with visual disabilities, 
iTunes offers some interesting features as an Alt Media tool. With the ability to 
organize and enhance a variety of digital formats in one application, the ability 
to create customized organization schemes to better organize your production 
files, allowing students greater flexibility in how they use the alt media you 
produce, and being a free download, iTunes is a tool worth having and knowing 
how to use.

Overview of iTunes Application
iTunes is a free application that can be downloaded from the Apple website 
(www.apple.com/itunes), and it allows you to enhance audio and video files in 
ways that make them easier to organize and manage, as well as making them 
more accessible for people with certain disabilities. Unfortunately, iTunes is not 
a very useful or accessible program for people who are blind or have low vision. 
While this inaccessibility for people who are blind or have low vision is a major 
issue, iTunes remains a popular application with many people seeking a tool for 
organizing and accessing digital media.

The iTunes interface is very graphically based, with redundant icon controls for 
many of the menu options. There are some keyboard commands available, but 
not for every function. It is possible to customize the iTunes interface to display 
specific information, and you can create custom genres to help organize your 
information.

iTunes Main Interface

http://www.apple.com/itunes
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Getting Files into iTunes
There are two primary ways to get files into iTunes. You can import files from 
a standard audio CD, or you can import files via direct digital transfer (moving 
files that are already digitized and available through your computer’s hard drive, 
USB, network, or internet connection).

NOTE: You can import an entire file folder into iTunes, by selecting “File” 
and then choosing “Add Folder to Library…” 

Organizing Files in iTunes
iTunes offers several ways for you to organize media files. Once you have a file 
imported into iTunes, it will be displayed in the iTunes main windor. The library 
media selector is located in the upper part of the left-side control frame:

When you select a type of media file in the library, the corresponding files 
are displayed in the main content window. You can quickly switch the main 
window view between a detailed list and combinations of a detailed list and 
album art. Selecting a media file from the main content window will allow 
you to play that file by using the control buttons from the top frame or from 
the menu bar (or you can double click the file). When you play a media file in 
iTunes, information about the song is displayed in the center of the top frame 
(the iTunes Status Display), or alternately, you can display the audio frequency 
levels of the file in real time, via the iTunes stereo graphical equalizer display.

NOTE: You can determine which icons will be displayed under the Library 
in the “General” tab of the iTunes Preferences dialogue.

Getting File Information
To access and change the file information within iTunes, use the “Get Info” 
dialogue. To bring up the “Get Info” dialogue for a file (or group of files), select 
the file(s) within iTunes, and either select “Get Info” from the “Files” menu 
(Files\Get Info), press CTRL+I, or right-click on the file(s) and select “Get Info” 
from the available options. This will bring up the “Get Info” dialogue for iTunes 

iTunes Library Media Selector
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(if you have multiple files selected, you will be prompted to determine if you 
really want to set information for multiple files). It is important to remember 
that you will be able to access more types of information for single files than 
you can with multiple files selected.

Summary
The Summary tab displays the basic information about the file, including its 
size, location, file format, and other useful information.
	
Info
The Info tab contains information such as Name, Album, Artist, Genre, and 
others, including a comments field.
 	
Options
The Options tab provides the tools for creating custom volume and equalizer 
settings, as well as controls for different timing settings.
	
Lyrics
The Lyrics tab features a text field where you can insert Lyrics or Text 
Transcripts for the audio file. This information can then be viewed during 
playback on iPods.
	

iTunes Information Dialogue
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Artwork
The Artwork tab allows you to embed artwork for the file.

Searching for Files
You can search all information displayed in the iTunes library, by using the 
Search window in the upper right corner of the iTunes main interface.

Converting File Formats
When you convert a file format in iTunes, you are actually creating a copy 
of that file in another format. In order to convert a file format, you must first 
specify the format you want to convert to by using the iTunes Preferences 
dialogue. You can access the import settings by opening the iTunes Preferences 
dialogue and selecting the “Advanced” tab, and then selecting the “Importing” 
tab.

Import Options in iTunes Preferences Dialogue
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Genres
One of the useful features of iTunes is the ability to create custom genres. You 
can specify a custom genre through the “Info” tab of the iTunes “Info” dialogue, 
by simply typing in the name you want to use directly into the Genre field. This 
gives you the ability to create your own indexing system for the files you create.

Enhancing Audio Files for Accessibility
iTunes offers some helpful features for making audio files more accessible as 
well as more user-friendly. Audio files can contain a text transcript that can be 
viewed during playback, and they can be converted to an audiobook format. 
The audiobook format allows iPod users to control the playback rate of the file, 
and it remembers your place if you have to stop listening to the file part way 
through.

Embedding text transcripts in audio files using iTunes
Using iTunes, it is possible to add a text transcript to most audio files that can 
be viewed with the iTunes application as well as the newer iPods with digital 
displays. There are two audio formats that do not support this capability in 
iTunes: WAV and Quicktime Audio. Unfortunately, iTunes limits the amount 
of text you can insert in the Lyrics field to about 64 KB, so arrange your media 
accordingly.

Genre Selection/Specification field in iTunes Info dialogue
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To insert a text transcript into an audio file:
First copy the text transcript to your clipboard, using your word processor of 
choice.

Next, open the iTunes application.

Locate the audio file in the iTunes library.

Select the audio file by clicking it with your mouse.

Open the Information dialogue, either through the File menu (File\Get Info), 
by pressing Ctrl+I, or right-clicking the file and selecting “Get Info” from the 
available options.

Once the Information dialogue is open, select the “Lyrics” tab.

Click inside the text window and press CTRL+V to paste the text transcript into 
the window.

Click “OK” at the bottom of the Information dialogue.

Creating Audiobooks in iTunes
The audiobook format is built on the ACC format, which means you must begin 
the process with an audio file in AAC format. If your audio files aren’t AAC, 
use iTunes to convert them to AAC. 

In order to convert the files to AAC, you will first need to select AAC as the 
import format from your iTunes Preferences dialogue. 

From the “Advanced” tab of your iTunes Preferences dialogue, select the sub-
tab labeled “Importing”.

Select “AAC” from the “Import Using:” pull-down menu, and click “OK”.

Setting the Import Options to AAC
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In the main window of iTunes, select all of the files you are converting to AAC. 
Right click on any of the selected files, and choose “Convert to AAC”. iTunes 
will begin the conversion process, and you can view the progress in the iTunes 
status window.

Once all of the files have been converted to the AAC file format, right click on 
one of the files and select the option “Show in Windows Explorer”. A window 
will open, displaying the directory on your hard drive that contains the AAC 
file. 

Notice that the AAC files end with an .m4a extension. This extension must be 
changed to .m4b to convert the files into the Audiobook format. You can do this 
one file at a time through Windows Explorer, or you can use the command line 
to process them all at once.

Using the Command Line
To use the command line for changing the file extensions of the .m4a files, Click 
on the Windows START button and select “Run…”. In the window that appears, 
enter “cmd” in the text field labeled “Open:” and then click “OK”. A command 
line window will open. 

Navigate to the Folder
Type “cd” followed by a space and then the complete directory path to the file 
as displayed in Microsoft Windows, and press <ENTER>. You should now be in 
the directory where your AAC files are stored. To verify this, type the command 
“dir”. If a listing of your AAC files is displayed, then you have successfully 
navigated to the correct directory. 

Changing the Extension
To change the extensions of all your AAC files from .m4a to .m4b, enter the 
following command: “ren *.m4a *.m4b” (There is a space after “ren” and after 
“*.m4a”). This will change all of the .m4a file extensions to .m4b extensions. 
Enter the “dir” command again to verify that the .m4a files are now .m4b files, 
and then type “exit” to close the command line window.

Cleaning Up
Now you must clean up the leftover files in iTunes. Because we made the 
changes to the file extensions outside of iTunes, it still expects to see the .m4a 
files. iTunes will still display the files, but if you try to play them you will get an 
error message. These .m4a files in the iTunes Music library are now just broken 
placeholders. To clean out the old .m4a files, select them and press the delete 
key.
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Getting the Audiobook into iTunes
In order to get the .m4b files to display in iTunes, you have to add them to your 
library through iTunes. 

Go to the “File” menu of iTunes and select “Add Folder to Library…”. 

Navigate to the folder that contains the .m4b files, and select “OK”. 

iTunes will process the files in that folder and add them to your Audiobooks 
Library.

Now that you have the files in Audiobook format, you will want to make sure 
that they can be easily accessed. iPods don’t offer the ability to manage the 
audiobook files by album or artist, which means all of the files will be listed 
by song name first, and then the artist. Consider making each chapter title 
begin with the name of the book for more convenient use on the iPod devices. 
Entering the correct data in the “Track #” fields will also help keep the files 
properly organized.

Enhancing Video Files for Accessibilty
iTunes will allow you to play Quicktime MOV format videos as well as MPEG4 
format videos. Once you have these video files in your iTunes library, you 
can add the same sorts of information to them that you can add to audio files. 
However, if you want to add synchronized captions, you’re going to have to do 
it outside of iTunes.

A popular option for creating captioned video files for iTunes and iPods is 
Quicktime Pro, though you can use a variety of other tools to perform digital 
captioning. When using Quicktime Pro, choose to export as MPEG4 in order to 
retain the captions, exporting as iPod movie strips out the captions.

No matter what tool you use to perform your digital captioning, remember 
that some people may choose to watch the video on their iPod, so be sure to 
use a font size that is easily readable. Size 18 to 20 font on a 48 pt background 
generally works well. 

Using Playlists
Playlists are a powerful tool for organizing audio and video files within iTunes 
and on the iPod devices. There are two basic types of playlists, “Smart” playlists 
and regular playlists. The primary difference between a Smart Playlist and any 
other playlist is that Smart Playlists can be automated to keep themselves up to 
date and otherwise properly managed whereas regular playlists require manual 
intervention in order to be changed or updated.

NOTE: When using “Smart Playlists” having the “Live updating” option 
will cause any copies you make of the source files to be added to the playlist 
automatically.
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Creating Playlists
To create a regular Playlist in iTunes, go to the File menu and select “New 
Playlist”. A new playlist will appear at the bottom of the Library, with the text 
“untitled playlist” highlighted in blue. Type the name for the playlist and press 
<ENTER>. 

To create a Smart Playlist, go to the File menu and select “New Smart Playlist”. 
A dialogue box will open with options for configuring the smart playlist.

Using Genres and Smart Playlists
Smart Playlists can be used to organize information by using Genres to 
selectively filter out or selectively include different criteria. You can use 
multiple selection criteria to create a variety of different playlists that will keep 
themselves updated with any new media you add to the library matching their 
specifications.

Burning Files to a CD
You can use iTunes to burn media to a CD if your computer has a recordable 
CD drive. To do this, first create a playlist and add the files you want to burn to 
CD. Next, select the playlist and then select “Burn to Disc” from the File menu. 
Alternatively, you can click the “Burn to Disc” icon that appears in the lower 
right corner of iTunes when you insert a blank disc into the recordable CD 
drive.

Creating a Smart Playlist in iTunes

Burn to Disc Icon
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DAISY to iPod
It is possible to use digital text to create audio files by using the Phoneticom 
DAISY Generator. Using the DAISY file, you can convert the text and audio 
into enhanced MP3 files for students, and for those students with iPods, you can 
even make Audiobooks that allow you to adjust the playback rate in addition to 
keeping your place when you stop in the middle of a file. Because iTunes will 
only allow you to insert about 64 KB of text in the Lyrics field, you must create 
the DAISY book with sufficiently sized sections.

To convert the DAISY file, you will need to use Windows Explorer, an HTML 
browser such as Firefox or Internet Explorer, and iTunes. You will obtain the 
text for each MP3 file by copying the appropriate text from the .html files in the 
DAISY book. Then you will insert that text into the Lyrics field of the MP3 file.

NOTE: You can only insert 64 KB of data in the Lyrics field within iTunes.

Extracting text and matching it to sound:
In Windows Explorer, open the folder with your DAISY files, and select “View 
Details” from the “View” menu. 

Next, organize the files by “Type”. There will be a collection of .MP3 files, 
.SMIL files, and two .html files, “content.html” and “ncc.html”. Open the files 
“content.html” and “ncc.html”.

DAISY Files by Type
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content.html 
The content.html file contains exactly what it says it does, the contents of the 
DAISY book, in one continuous file. You will extract the text from the content.
html file to embed in the appropriate audio files within iTunes.

The data in content.html is separated into sections that begin with text formatted 
as Heading Level 1. These portions of text correspond to the MP3 files in the 
DAISY book, named “pageXXXX.MP3”, where “XXXX” represents a number. 
The first section of the content.html file corresponds to the MP3 file “page0001.
MP3”, and the second section corresponds to “page0002.MP3”, and so on till 
the end of the DAISY book.

Page Numbers
You will notice that occasionally a single number will appear with a blank line 
above and below it. These numbers that are separated from the rest of the text 
with blank lines are the page numbers, corresponding to the page numbers of 
the original print book. There is no special marker to identify them that you can 
see in your html browser, but the pattern of blank lines is distinctive enough to 

DAISY file “content.html”

Page Number
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allow for quick selection of data by page(s).

Parsing the Pattern of content.html
The very first item in content.html will be the title of the DAISY book formatted 
in heading level 1, followed by any text that might be on the first page, and then 
a blank line, and the number 1 followed by another blank line. The next line of 
text begins page 2, which will end with a blank line and a number 2 followed 
by another blank line, and then page 3 begins and continue on to a number 4 
separated by blank lines, and it continues on in this fashion.

Occasionally you will find a selection of text formatted as a heading level, and 
this indicates the beginning of a new section of the DAISY book, meaning 
a new MP3 file and corresponding set of text pages. In this manner you can 
identify which sections of text correspond to each MP3 file.

If you are comfortable examining the html code, there is a unique tag that 
identifies the page numbers, a <span> tag with a class designation of “page-
normal”. This can be helpful in situations where there are several numbers 
together and it is unclear which number is the actual page number of the DAISY 
book.

You can also use the NCC.html file to assist in the process of aligning specific 
sections of text with the corresponding MP3 files. The NCC.html file contains 
only the headings of each section, followed by a list of the page numbers for 
that section. Using the NCC.html file allows you to quickly see the title text of 

DAISY file “NCC.html”
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each section, and verify the last page number of text content for that section.

Preparing the Files for Text
Now that you can identify the separate sections of the DASIY book, you will 
bring the audio files into iTunes and then embed the corresponding text. 

Using iTunes, select “File” and then “add folder to library…”. 

Browse to the folder that contains your DAISY files, and select “OK”. 

iTunes will proceed to import the MP3 files into your library, and will ignore the 
other files. You can monitor the progress of this process in the status window of 
iTunes.

When iTunes has completed importing the files, you will want to enter 
information about the DAISY book to allow you to differentiate and manage the 
files.  

First, arrange the music files according to “Name”, and then scroll down to the 
“P” section and find the file named “Page0001”. 

All of the MP3 files from your DAISY book should be listed, from Page0001 to 
the end. 

Notice that the Album, Artist, and Genre columns are blank for these files. 
Before proceeding, you must first enter data into these fields in able to better 
manage the files. Without entering at least an Album name or Artist information, 
your DAISY files would quickly become lost in a sea of files all named 

Freshly Imported DAISY Files
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“Page0001”, “Page0002”, “Page0003”, etc.

Select the block of MP3 files and bring up the “Get Info” dialogue to enter the 
basic information of the DAISY book. You may be asked if you really want to 
change the information of many files at once, say yes.

When the Get Info dialogue appears, you can fill in the proper information 
from the DAISY book to identify the files. Enter student and book information 
where appropriate, and adapt every field to contain whatever organizational 
information you want to use to sort and search the information. When you are 
finished, click “OK” and the information will be added into the MP3 files.

Matching text to the sound files
Using your .html browser, open the file “content.html” from your DAISY book. 
Select the first heading and any following text, down to and including the last 
page number before the next heading. Copy this text to the clipboard, and 
switch back to iTunes.

In iTunes:
Select the first MP3 file from your DAISY book
 
Open the “Get Info” dialogue (CTRL+I)

Select the “Lyrics” tab

Click inside the blank text field of the Lyrics tab

Paste the contents (CTRL+V) of the clipboard into the text field of the Lyrics 
tab

Pasted Text in the Lyrics Field
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Check the last line of the text to verify all text was copied over. 

Using the NCC.html file as a guide, select the next set of pages to be inserted in 
the next MP3 file. 

Copy and paste the information into the Lyrics tab of the next MP3 file and click 
“OK”. 

Repeat the process for each of the remaining audio files. 

When you have finished, you will have MP3 files with embedded text that can 
be accessed by a variety of portable MP3 players and software applications.

NOTE: When selecting text in your internet browser: If you’re unsure 
whether a particular number is a DAISY page number or not, you can 
find the answer in the html code. The DAISY page numbers are identified 
in the .html source file by a specific tag that precedes the number: <span 
class=”page-normal”>.

Converting to Audiobook Format
There are two distinct advantages to using the audiobook format over the 
general audio format of iTunes, the ability to keep your place in a song, as well 
as the ability to decrease or increase the playback rate. 

In order to take advantages of these features, you must first convert your MP3 
files into AAC files.

NOTE: Some of the following steps may be easier to perform if you set 
Windows Explorer to display file extensions (Tools\Folder Options\”View” 
Tab).

In order to convert the files from MP3 to AAC, you will first need to select AAC 
as the import format from your iTunes Preferences dialogue.

From the “Advanced” tab of your iTunes Preferences dialogue, select the sub 
tab labeled “Importing”, and select “AAC” from the “Import Using:” pull-down 
menu.

In iTunes, select all of the MP3 files that make up the DAISY book. 

Right click on any of the selected files, and choose “Convert to AAC”. 

iTunes will begin the conversion process, and you can view the progress in the 
iTunes status window.

Once all of the files have been converted to the AAC file format, right click on 
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one of the files and select the option “Show in Windows Explorer”. A window 
will open, displaying the directory on your hard drive that contains the AAC 
file. Select the “Details” view, and notice that the original MP3 files are in the 
same folder, and that they are intermixed with the AAC files. Click the column 
titled “Type” to sort the information by file type.

Notice that the AAC files end with an .m4a extension. This extension must be 
changed to .m4b to convert the files into the Audiobook format. You can do this 
one file at a time through Windows Explorer, or you can use the command line 
to process them all in one batch.

Using the Command Line
To use the command line for changing the file extensions of the .m4a files, Click 
on the Windows START button and select “Run…”. In the window that appears, 
enter “cmd” in the text field labeled “Open:” and then click “OK”. A command 
line window will open. 

Navigate to the Folder
Type “cd” followed by a space and then the complete directory path to the file 
as displayed in Microsoft Windows, and press <ENTER>. You should now be in 
the directory where your AAC files are stored. To verify this, type the command 
“dir”. If a listing of your AAC files is displayed, then you have successfully 
navigated to the correct directory. 

Changing the Extension
To change the extensions of all your AAC files from .m4a to .m4b, enter the 
following command: “ren *.m4a *.m4b” (There is a space after “ren” and after 
“*.m4a”). This will change all of the .m4a file extensions to .m4b extensions. 
Enter the “dir” command again to verify that the .m4a files are now .m4b files, 
and then type “exit” to close the command line window.

Cleaning Up
Now you must clean up the leftover files in iTunes. Because we made the 
changes to the file extensions outside of iTunes, it still expects to see the .m4a 
files. iTunes will still display the files, but if you try to play them you will get an 
error message. These .m4a files in the iTunes Music library are now just broken 
placeholders. To clean out the old .m4a files, select them and press the delete 
key.

Getting the Audiobook into iTunes
In order to get the .m4b files to display in iTunes, you have to add them to 
your library through iTunes. Go to the “File” menu of iTunes and select “Add 
Folder to Library…”. Navigate to the folder that contains the .m4b files, and 
select “OK”. iTunes will process the files in that folder and add them to your 
Audiobooks Library.
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Now that you have the files in Audiobook format, you will want to make sure 
that they can be easily accessed. iPods don’t offer the ability to manage the 
audiobook files by album or artist, which means all of the files will be listed by 
song name first, and then the artist. 

You might want to make each chapter title begin with the name of the book for 
more convenient use on the iPod devices. Entering the correct data in the “Track 
#” fields will also help keep the files properly organized.

Using Notes
When you find that there is more text for an audio file than will fit in the Lyrics 
field, you can either try to break the file into smaller chunks or use the Notes 
functionality of iTunes and iPods. 

Notes are located in a folder marked “Notes” on the iPod. When an iPod is 
connected to your computer the Notes folder can be viewed through Windows 
Explorer (Disk Use must be enabled). Select the name of the iPod that appears 
when you connect the iPod to your computer, and you will find the Notes folder 
in addition to a few other folders. Notes can be up to 4 kb, and there can be up 
to 1000 notes on the iPod.

Not all iPod models support Notes files, so be sure to specify that the material 
must be displayed on a compatible iPod model. 

iPod models that support the Notes functionality:
•	 iPod mini 
•	 iPod with color display (iPod photo) 
•	 iPod (Click Wheel) 
•	 iPod (with Dock Connector) 
•	 iPod nano 
•	 iPod with video 

Notes Tags
There is a very limited tag set available for marking up your Notes files, and the 
tags don’t follow the strict rules of html, so beware! Some of the available tags 
include: 
<p> - paragraph tags
<br> - line break tags
<Title> </Title> - title element tag
<A HREF=”/main.linx” POPALL> Exit </A> - the anchor tag.

There are other tags available, as well as more information on using the Notes 
feature included in the “iPod Notes Feature Guide” from Apple, which is 
attached to the end of this manual.
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Linking to a Song
To link to the DAISY audio file, insert the following link in your Note file, with 
the appropriate songname for the text: <a href=”song=Page0001”>Cha
pter 1</a>.

Linking to a Playlist
You can insert a link to a playlist in a Notes file with the following query: 
<a href=”ipod:music?playlist=DAISY Chapters”>Play All 
DAISY Chapters</a>.

Linking to a Folder
You can link to a folder within your Note file, which when followed will display 
a list of all the folders and note files in that folder.

Using Queries to Filter Notes
If you are listening to more than one audio book at a time on your iPod, chances 
are pretty good that you’ll have more than one file labeled “Chapter 1”. In order 
to keep your iPod from playing the first Chapter 1 it finds, use queries to specify 
from which Album Chapter 1 will be playing.
Here’s a sample link for files in the Music Library: <a href=”ipod:music
?album=Sociology108!!&song=Chapter 1”>Chapter 1</a>

Here’s a sample link for files in the Audiobooks Library:
<a href=”ipod:audiobooks?album= Sociology108!!&song=Chap
ter 1”>Chapter 1</a>

Using images in Notes
You can link to image files in your Notes, provided they are jpeg files and stored 
in the Notes folder hierarchy.

Special Notes
There are four special types of Note files used to perform advanced functions, 
they are:
•	 Preferences note: Holds global settings for your presentation.
•	 .link note: A note used as an alias to a note or media file.
•	 .linx note: A note used to specify a menu.
•	 ERRORS note: A note used for debugging purposes.

More information about the Notes features of iTunes and iPods: http://
developer.apple.com/hardwaredrivers/ipod/iPodNotesFeatureGuideCB.pdf

http://developer.apple.com/hardwaredrivers/ipod/iPodNotesFeatureGuideCB.pdf
http://developer.apple.com/hardwaredrivers/ipod/iPodNotesFeatureGuideCB.pdf
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